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Release Date Description

IntelliCAD 6.3 3/1/2007 New DWG format support up to DWG 2007.

IntelliCAD 6.2 4/27/2006 New features, such as True Color support, and other improvements.
IntelliCAD 6.1 9/5/2005 New features and improvements, such as enhanced rendering capability.
IntelliCAD 6.0 5/3/2005 New features, such as print style tables, and other improvements.
IntelliCAD 5.1 1/12/2005 Maintenance release.

IntelliCAD 5 10/24/2004 | New DWGformat support up to DWG 2004.

IntelliCAD 4 3/14/2003 New features, such as multiple layout support, and other improvements.

IntelliCAD 2001 v3.3 7/19/2002 Maintenance release that runs on the Windows XP operating system.

IntelliCAD 2001 5/22/2001 New features, such as linetype support, and other improvements.
IntelliCAD 2000 3/6/2000 New features and performance improvements.

IntelliCAD 99 Beta 9/1999 Releaseby Visio Corporation for the creation of the ITC.
IntelliCAD 98 4/1/1998 First release by Visio Corporation.

InteliCAD(R) 6.3 by InteliCAD Technology Consortium

IntelliCAD 6.3 was released 3/1/2007.

New features

Work with DWG 2007 files

IntelliCAD supports opening, modifying, printing, and saving drawings in DWG 2007 format. The DWG 2007 format is now the
default format in which IntelliCAD drawings are saved.

Create and edit color books
Now you can create and edit color books, which help you organize collections of colors, right from IntelliCAD.

Work with images

IntelliCAD Professional version includes enhanced imaging features to help you work with images in your drawings. Working with
images is similar as in previous IntelliCAD versions, with easy-to-use features located on the Image menu in IntelliCAD.

Use new layout viewport features
There are several new features for layout viewports:

e Snap to model space entities from paper space.
e | ock layout viewports to lock the model space view or location while panning or zooming in paper space.

e Assigna unique UCSto a layout viewport.



Manage character sets for drawings

IntelliCAD allows you to manage which character set is assigned to a drawing. This unique feature can be very helpful when
sharing or distributing drawings in geographic regions where several languages are used that require different character sets to
display text properly.

Reverse the zoom direction of the mouse wheel

Instead of zooming in and out by moving the mouse wheel forward and backward, you can reverse the settings to zoom in
when spinning the mouse wheel backward and zoom out when spinning the wheel forward. This can be especially helpful if you
use the mouse with your left hand.

Use new and enhanced system variables

New system variables include: 3DDWFPRECPIMARCSYMDPWGCODEPAGHMAGEHLT,RASTERVERNUMRTDISPLAY, UCSVP,
and ZOOMWHEELL.

Enhanced system variables include: DELOBJ,FACETRATIOHALOGAP HIDEPRECISIONOBSCUREDCOLORBSCUREDLTYPE,
OLEQUALITY and TEXTEVAL.

New system variables supported for DWG file compatibility: CAMERADISPLAYCAMERAHEIGHTCMATERIAL,CSHADOW,
DEFAULTLIGHTINGPEFAULTLIGHTINGTYPE)IMFXL, DIMFXLON,DIMJOGANGLEDIMLTEX1,DIMLTEX2,DIMLTYPE,DIMTFILL,
DIMTFILLCLR,DRAGVS DWFFRAMEDWFOSNAPDWGCHECKGRIDDISPLAY GRIDMAJOR,INTERFERECOLOR,
INTERFEREOBJV&ATITUDE, LEGACYCTRLPICKJGHTGLYPHDISPLAWIGHTLISTSTATELOFTANG1,LOFTANG2,LOFTMAGL,
LOFTMAG2,LOFTNORMALSL.OFTPARAMLOGNITUDE,NORTHDIRECTIONOSOPTIONS PERSPECTIVERSOLHEIGHT,
PSOLWIDTH,PUBLISHALLSHEETSHADOWPLANELOCATIONHOWHIST, SOLIDHIST,STEPSIZE STEPSPERSEGUNSTATUS,
TIMEZONE,UCSDETECTYSBACKGROUNDSY/SEDGEJITTERYSEDGEOVERHANG,SEDGESYSEDGESMOOQOTH,
VSFACECOLORMODKESFACEHIGHLIGHTYSFACEOPACITWSFACESTYLE/SHALOGAPYSHIDEPRECISION,
VSINTERSECTIONCOLOR/SINTERSECTIONEDGEYSINTERSECTIONLTYPE,SISOONTOPYSLIGHTINQUALITY,
VSMATERIALMODEYSMONOCOLORYSOBSCUREDCOLORSOBSCUREDEDGESSOBSCUREDLTYPESSHADOWS,
VSSILHEDGESand VSSILHWIDTH.

Performance
e Improved performance and reduced screen flickers while using dynamic zoom and pan in paper space.
e Rasterimage performance has been improved greatly for both large image files and many other image files.

e A large memory leak with handling complex meshes was removed.

Open and save files
e IntelliCAD uses the new DWGdirect 2.2 libraries.
e When opening drawings, external references now display properly in the drawing preview.

e Severalimprovements were made to auditing and recovering corrupt drawing files.

Export files

e When exporting a drawing to a PDFfile, paper size enhancements allow you to select from a list of standard paper
sizes, specify a custom size, and choose millimeters or inches for the paper size.

e \When exporting a drawing to a PDFfile, the drawing is now centered properly and exports to the correct size and
units.
Raster images (InteliCAD Professional versions)
e Some raster image types would lose their paths after saving or reloading; this has been fixed.
e RTDISPLAYis now supported for raster images.
e The 280 group code for an image entity now roundtrips properly.

e The Image command is now disabled when no drawing is active.



e The Image dialog box settings are no longer lost when switching between active images in the list box.
e Previewing images is faster for very large image files.

e Mirrored images properly display in the Image Manager.

COM API calls (IntelliCAD Professional versions)
e Adeko raster images can now be inserted via the COMAPI.
e You can now properly iterate, rename, and delete layouts via the COMAPI.
e The COMAPI now checks that layout names are using valid characters.
e You can no longer open the VBAIDE when no drawing is active.
e Text created with the COMAPI now respects the width and other properties associated with the text style.
e The Boolean UNION COMAPI interface now properly deletes original input entities.
e When a corrupt file is opened via the COMAPI, an exception is thrown to indicate a problem.

e The objects, properties, and events in the following table have been updated or added to the COMapplication
program interface.

Objects Events

Application EndCommand
EndLisp
EndModal
EndOpen
EndPlot
EndSave

Exit
LispCancelled
New
NewDrawing
Open

Reinitialize

Save

Startup
SysVarChanged
WindowChanged
WindowMovedOrResized

Document Activate
BeginClose
BeginCommand
BeginDocClose
BeginDoubleClick
BeginLisp
BeginPlot
BeginRightClick
BeginSave
Close
Deactivate
EndCommand
EndLisp
EndPlot




EndSave
LayoutSwitched
LispCancelled

Open

Save

SelectionChanged
WindowChanged
WindowMovedOrResized

Workspace

EndCommand
EndLisp
EndModal
EndOpen
EndPlot
EndSave

Exit
LispCancelled
New
NewDrawing
Open

Reinitialize

Save

Startup
SysVarChanged
WindowChanged
WindowMovedOrResized

Objects

Properties

ApplicationPreferences

Files

PreferencesFiles

AltFontFile
Application
BlockFilePath
ColorBookPath
DrawingFilePath
FontFileMap
FontFilePath
HatchPatternPath
HelpFilePath
LogFilePath
MenuFile

Parent
PrintOutputPath
PrintStylePath
QNewTemplateFile
TempFilePath
TemplateDWGPath
TempXRefPath

LISP




Text

Printing
[}

The DIMOVERRIDEcommand now works properly via the LISP (command) function.

IntelliCAD no longer intermittently crasheswhen editing MTEXT.
The -STYLEcommand properly handles style names that contain spaces.

IntelliCAD no longer intermittently crasheswhen using the Text toolbar to change text styles.

Print preview of mirrored text is now correct when MIRRTEXTis 0.

IntelliCAD versions built with Visual Studio 2003 could hang when exiting the Print Preview command; this has been
fixed.

Entities with the property BYBLOCK®but not contained in blocks) are printed properly.
The default lineweight for print style tables is now set to Use Entity Lineweight.
The Print and Print Preview commands now support wipeout frames.

In some cases attributes did not properly appear in the Print Preview window; this has been fixed.

Blocks and external references

The External Reference command now remembers the previous path specified.

Some nested blocks and external references did not display properly when SORTENTSwvas enabled; this has been
fixed.

Block entities now support the LWDEFAULTvalue correctly.
In some cases IntelliCAD would crash when using COPYCLIFon external reference entities; this has been fixed.
In some cases IntelliCAD would crash when using WBLOCKon external reference or block entities; this has been fixed.

The Insert command now defaults to search a block's path specified in the Options dialog box on the Paths tab.

Viewports

You can now snap to entities in model space from paper space.
The Plan command now works properly with layout viewports (MVIEWS).

In some cases IntelliCAD would display the wrong layout viewport when multiple layout viewports were active; this
has been fixed.

In some casesa corrupt layout viewport could be created when viewport entities were deleted; this has been fixed.

Dimensions

Dimensionsin layout viewports that snap to model space geometry no longer lose associativity upon UPDATE.

Draworder

Improvements were made to draworder for blocks, external references, hatching, and text.

e Wipeout entities properly support draworder.

Circle entities

Display

The Tangent-Tangent-Tangent option is now available for circle creation.

The Tangent Snap cursor is properly displayed while creating a circle using the Radius-Tangent-Tangent option.

e Tolerance plus and minus symbols and diameter symbols now display correctly in Japaneseversions of IntelliCAD.



On some displays the layer control on the Properties toolbar could react to clicks outside of the control; this has been
fixed.\

OLE objects display correctly when WBLOCKedto a new drawing file.

Entity selection

Selection for overlapping block entities has been improved.
OLE objects can now be selected with a crossing window.

Using Shift+click to select entities for editing in the Properties dialog box no longer intermittently disables selection
until IntelliCAD is restarted.

Entity snaps

You can now properly press Tab to cycle through entity snaps.

IntelliCAD no longer intermittently goes into an infinite loop when trying to snap to complex NURBScurves.

More fixes

You can now create a CFrameWndwindow from an SDSDLL when building with Visual Studio 2003.

IntelliCAD no longer crashes during the cancellation of a Text Style or Dimension Style in the IntelliCAD Explorer.
Localization problems with the Linetype toolbar control have been resolved.

Scrolling on the status bar layer control has been enabled.

The Fillet command works properly on lines with different linetypes.

The OK button in the Boundary dialog box is properly enabled.

Exploding a block or region with varying positive and negative scale factors no longer causes arc segments inside the
block to lose their proper starting and ending angles.

The PASTECLIRRommand now allows you to specify an insertion point.

Some alerts and message boxes were not proper child windows of IntelliCAD, which were causing some contextual
problems; this has been fixed.

Some entities could lose extended entity data during mirror and copy operations; this has been fixed.
Using the Offset command on self intersecting polylines produces improved results.

Grip editing of certain entities now properly updates extended entity 3D coordinate data (group codes 1011, 1021,
1031).

ATTDEFentities now properly keep their alignment during roundtrip.

IntelliCAD works properly now when using the BHATCHcommand and a specified hatch pattern does not exist.
The command bar can now accept and display multi-byte characters.

The OBSCUREDCOLOBhd OBSCUREDLTYP&ystem variables now roundtrip properly.

Several enhancement were made to improve user profiles.

RTPANnow works properly in paperspace when RTSKIPCOUNTs set to a value other than 0.

WBLOCKnow properly supports wipeout entities.

Reloading the same linetype several times no longer causes an infinite loop.

The prompt box now displays for the main Line, Circle, Arc, and Polygon commands when they are activated from the
toolbar.



IntelliCAD 6.2 was released on 4/27/2006.

Assign true colors and color book colors
YouOvealways been able to add color to your drawings using index colors, but now you use two new color features:

e True colors N Defined using 24-bit color, there are more than 16 million true colors from which you can choose.

e Color books N Defined with a list of colors, color books help you organize collections of colors. For example, you can
store a unique color scheme in a color book for a client and then use colors only from that color book for the clientOs
drawings.

Work with raster images using ADeko Raster

IntelliCAD Professional version includes new raster imaging software to help you work with images in your drawings. Working
with raster images is similar to previous IntelliCAD versions, with easy-to-use features located on the Image menu in IntelliCAD.

Export to PDF and 3D DWF format
You can export drawings to two new formats:

e PDF N Portable Document Format files allow you to distribute your drawing to others for viewing with Adobe”
Acrobat” Reader”, which is free software that users can download, and for viewing, reviewing, and editing with
Adobe” Acrobat.

e 3D DWF N 3D Design Web Format files can be viewed in a Web browser if Autodesk” DWF Viewer is also installed
on the computer. DWF Viewer is a free tool from Autodesk” that always supported viewing 2D DWF files, but now
supports viewing DWF files in three dimensions.

Use entity snaps

When using the extension option with Intersection Snap and Apparent Intersection Snap, IntelliCAD draws dashed extension lines
to help guide you as you use the extension snap option.

If you are working in the command bar, you can modify the active command by typing m2p or mtp to enable a one-time snhap
to the midpoint of two points that you specify.

Edit text in the command line

The command bar and Prompt History window include enhanced text editing, including cutting, copying, and pasting text;
copying the last command line or the entire command history; and repeating a previously executed command.

Create wipeout entities

Wipeouts are unique entities that can help you hide areas of your drawing. They display with the current background color, so
the details behind the wipeout do not display or print. However, if your version of IntelliCAD does not include raster image
capability (that is, does not include an Image menu), wipeout entities display, but the details behind the wipeouts also display.

Create audio notes from existing *. wav files

In addition to recording audio notes in IntelliCAD and attaching them to entities, you can now create audio notes from existing
*.wav files. Audio notes created from an existing *.wav file are saved in the drawing file and the separate *.wav file remains
unchanged.

View thumbnails of drawings

When you open or save a drawing, drawing files can be displayed in a number of ways, including by filename with or without
the additional details. Now you can also view thumbnail images of drawing files.

You can also view thumbnail images when you browse drawing files on your computer using programs that came with your
operating system, such as Windows™ File Explorer or My Computer.



Use new and enhanced system variables
New system variables include: AUDIOICONCOLORNOMUTT, OSNAPCOORDQSNAPHATCHOSNAPZ,and RTSKIPCOUNT.
Enhanced system variables include: CECOLORand SNAPCOLOR.

Display
e In some cases IntelliCAD improperly clipped block sub-entities and they did not display.
e The display of Chinese characters has improved due to better handling of double-byte characters.
e The handling of visibility flags on attributes is improved.
e Sub-entities in blocks properly support the display of lineweights.
e Dimensions from earlier DWG versions are not translated to new locations when a drawing is opened.
e Clipping is improved for overlapping viewports.
e Mview viewports saved as "Off" in IntelliCAD do not display as "On" in Autodesk™ AutoCAD".
e Draworder has been greatly improved for entities within blocks and external references.

e Draworder is properly retained for edited entities (Copy, Block, Move, etc.).

Open and save files
e IntelliCAD uses the new DWGdirect 1.14.02 libraries.
¢ IntelliCAD properly saves binary extended entity data.
e Extended entity data on group objects and view entities is saved properly.
e Corrupted or missing plot styles do not prevent entities from being saved.

e New actions are taken to help prevent data corruption when opening and saving drawings. If necessary, additional
error messagesdisplay.

e Opening files includes general performance improvements.

e IntelliCAD saves the active drawing first (rather than non-active drawings first) when multiple files are open and
IntelliCAD is closed.

COM API calls (IntelliCAD Professional versions)
IntelliCAD now uses the 6.4 VBA SDKversion.
Print parameters can be set correctly through the COMAPI.

The objects, methods, and properties in the following table have been updated or added to the COMapplication program
interface.

3DSolid ArrayPolar Application
ArrayRectangular Centroid
Boolean Color
Checkinterference Document
Copy EntityName
Delete EntityType
Erase Handle
Explode HasExtensionDictionary
GetBoundingBox Layer
GetExtensionDictionary Linetype
GetXData LinetypeScale
Highlight Lineweight
IntersectWith MomentOfinertia



Mirror Parent
Mirror3D PlotStyleName
Move PrincipalDirections
Rotate PrincipalMoments
Rotate3D ProductOflnertia
ScaleEntity RadiiOfGyration
SectionSolid Thickness
SliceSolid Visible
SetXData Volume
TransformBy
Update
Application Activedocument
Dictionary AddObject Application
AddXRecord Count
Delete Document
GetExtensionDictionary Handle

GetName

HasExtensionDictionary

GetObject Item

GetXData Name

Remove Parent

Rename

Replace

SetXData

Dictionaries Collection | Add Application

Count
Item
Parent

Dimension

TextPrecision
AltRoundDistance
DecimalSeparator

Entity Objects (all)

GetExtensionDictionary

HasExtensionDictionary
Lineweight
PlotStyleName

Group

Appendltems

Delete
GetExtensionDictionary
GetXData

Highlight

Removeltems
SetXData

Update

Application
Color

Count
Document
EntityName
EntityType
Handle
HasExtensionDictionary
Item

Layer

Linetype
LinetypeScale
Lineweight
Name

Parent
PlotStyleName
Visible

Groups Collection

Add

Application
Count

Item
Parent

Layer

PlotStyleName
ViewportDefault




PlotProperties GetCustomScale OptimizeLevel
SetCustomScale OriginX
OriginY
Pens
PenWidth
Rotate
StandardScale
UseStandardScale
Units
Version
Region ArrayPolar Application
ArrayRectangular Area
Boolean Centroid
Copy Color
Delete Document
Erase EntityName
Explode EntityType
GetBoundingBox Handle
GetExtensionDictionary HasExtensionDictionary
GetXData Layer
Highlight Linetype
IntersectWith LinetypeScale
Mirror Lineweight
Mirror3D MomentOfinertia
Move Normal
Rotate Parent
Rotate3D Perimeter
ScaleEntity PlotStyleName
SetXData PrincipalDirections
TransformBy PrincipalMoments
Update ProductOflnertia
RadiiOfGyration
Thickness
Visible
Shape ArrayPolar Application
ArrayRectangular Color
Copy Document
Delete EntityName
Erase EntityType
GetBoundingBox Handle
GetExtensionDictionary HasExtensionDictionary
GetXData Height
Highlight InsertionPoint
IntersectWith Layer
Mirror Linetype
Mirror3D LinetypeScale
Move Lineweight
Rotate Name
Rotate3D Normal
ScaleEntity Parent
SetXData ObliqueAngle
TransformBy PlotStyleName
Update Rotation
ScaleFactor Thickness
Visible
SolidCreator AddBox Application
AddCone Parent
AddCylinder

AddEllipticalCone
AddEllipticalCylinder
AddExtrudedSolid

AddExtrudedSolidAlongPath

AddRegion
AddRevolvedSolid
AddSphere




Window

XRecord

Dialog Control

Hatches

Text

Zoom

AddTorus
AddWedge

Scroll

Delete
GetExtensionDictionary
GetXData
GetXRecordData
SetXData
SetXRecordData

Caption
WindowHandle32
WindowState

Application

Document

Handle
HasExtensionDictionary
Name

Parent

TranslatelDs

Language (DCL)
DCL list boxes and DCL images display the proper height.

DCL list boxes handle truncation correctly.

When associative hatches are erased, their boundaries are no longer erased with them.

Direction on ellipses and elliptical arcs are not changed when the drawing is saved, which had previously caused
issues when these entities were used as hatch boundaries.

The Bhatch command can use entities inside a block as a boundary edge.
User-defined hatch patterns do not have their base point reset when the drawing is saved.
Non-associative hatches do not display as associative in the Hatch dialog box.

The Bhatch dialog box and the HPASSOGystem variable are now synchronized.

Text and MText now support the display of UNICODEcharacters.

The justification and display of TrueType fonts is improved.

Text is no longer modified when opening and closing the DDEdit dialog box.
IntelliCAD does not crash when adjusting the ruler in the Mtext dialog box.

The Mtext dialog box displays with the current background color and all text colors appear the same as in the
drawing.

Vertical text grip point and direction now more closely match AutoCAD.

Mtext paragraph tab justification is improved and more closely matches AutoCAD.
Formatted text pasted from Excel appears formatted correctly in IntelliCAD.

Font mapping includes general improvements.

Diameter symbols display properly in Mtext.

Mtext supports the Explode command.

Stack text diagonally (\S1#2).

Transparent zooms do not disable the current selection.
Entity snaps can be used to specify points for a Zoom window.

The Zoom command properly finds the extents of dimension entities.



Although the Dynamic Zoom option was available previously, it is now located in the list of command options and in
the menus.

Print features

IntelliCAD properly prints lineweights less than 2 millimeters.

Dot hatch patterns print correctly and display in the Print Preview window correctly.
IntelliCAD opens CTB and STBprint style table files created in AutoCAD2005 and 2006.
IntelliCAD handles corrupted CTB and STBprint style table files better.

Cancelingthe Print Preview window no longer closes IntelliCAD.

ACIS and 3D solids
IntelliCAD uses the new ACIS R15 SP3libraries.

Rendering

IntelliCAD uses the latest DaVinci Rendering 5.6.4 libraries.

Offset

Support
[}
[}

Mview

Installer

The Offset command includes better handling of polylines that have a large number of vertices close together (that is,
short distances between vertices).

The Offset command trims degenerate parts when the resulting curve self-intersects.

for Trim and Extend commands

General improvements were made to handle complex casesfor the Trim and Extend commands.
Ray entities support the Trim command.

Dimension entities support the Trim and Extend commands.

Wipeouts support the Trim and Extend commands.

Image entities support the Trim and Extend commands.

Polyline entities have improved support for the Trim and Extend commands.

Mviews that are turned off are properly supported.

Mview group 90 codes are saved properly.

The IntelliCAD installer has been completely re-written with InstallShield 10.5.

More fixes

Layouts do not disappear when they are renamed.

Performance has been increased 8X when inserting drawings with large polyface meshes.
Chamfers can be created between lightweight polyline and line entities.

The New Drawing Wizard does not create multiple files when Finish is clicked multiple times.
Toolbars are no longer moved from their previous position during IntelliCAD startup.

Mlines can be exploded properly.

The Undo stack is not corrupted while scrolling with the mouse wheel.

When a parent drawing is saved, linetypes are not changed to Continuous in external references.

Header and footer controls in the Options dialog box show correct data.



e Dimension values do not change when copying and pasting from one drawing to another drawing.
e The Area command computes the area correctly.

e Proxy entities can be deleted.

e The Hide and Shade commands work properly in perspective view.

e [ntelliCAD no longer randomly hangs when the focus switches to another application while changing the drawing
settings.

e |IntelliCAD no longer crasheswhen snapping to the intersection of nested block entities.
¢ IntelliCAD no longer hangs when the vertically docked command bar is minimized.
e IntelliCAD no longer randomly crashes after browsing linetypes in IntelliCAD Explorer.

e Many memory leaks have been fixed, including large leaks when handling meshes.

IntelliCAD 6.1 was released on 9/5/2005.

Create rendered images
IntelliCAD uses new and enhanced rendering features to create higher-quality and more photo-realistic images of models.

Both IntelliCAD Standard and IntelliCAD Professionalinclude the new rendering solution, while some versions provide additional
rendering capabilities with a complete set of materials, backgrounds, lighting options, and render settings.

Format text

New formatting features are available when you enter text using Insert > Multiline Text. You can specify text color, first line
indents, paragraph indents, right indents, and tabs.

Attach and record audio

IntelliCAD provides the unique ability to record audio notes, which are sound clips attached to entities and available for playback
at any time. For example, audio notes in a factory floor plan can describe maintenance activities for specific areas of the factory
and employees can play the audio notes to hear instructions.

Work with 3D solids

In addition to slicing and sectioning solids, you can now slice regions and bodies (typically sheets). This feature is available if
your IntelliCAD version supports editing ACIS solids.

Use entity snaps
You can now snap to hatch patterns when using entity snaps:
e Snap to the middle points and end points of hatch pattern lines.
e Snap to the nearest point and perpendicular point on a hatch pattern line.
e Snapto any intersection point or apparent intersection point where the pattern line intersects with other entities that

are supported by entity snaps.

Use new system variables
New system variables include: AUDIOICON,AUDIOICONCOLORand AUDIOICONSCALE.



Multiline

text
The text height for multiline text is saved correctly now when exiting the MTEXTcommand dialog box.
The formatting for the MTEXTcommand (Bold, Italic, and Underline) now works correctly.
You can now use both begin and end curly braces appropriately with the MTEXTcommand.

MTEXTentities can now be used as a cutting edge with the TRIM command.

Entity snaps

Hatches
[
[ ]

Linetypes

Extended intersection snap now works properly.

IntelliCAD snaps are no longer stuck on a single location and they no longer require that the snap be reset.

When moving hatches, any associated boundaries move with the hatch.
The ARRAY,ARRAY3D MIRROR,and MIRROR3Dcommands now work with hatch entities.
Hatch scale is saved correctly.

Solid hatches utilize all spline knot boundaries correctly. This also fixed minor problems with the display of Kanji
characters.

If a hatch entity has the same name as a hatch pattern in the ICAD.PATfile but contains a different definition, that
entity's hatch definition is no longer redefined on save.

Hatch entities work better with the CHANGEand ENTPRORcommands.
Enhanced performance when working with dense hatch patterns, including patterns that are too dense to display.

Dynamic dragging is approximately five times faster when dragging inserted blocks that contain hatch entities.

User-defined complex linetype patterns are now saved and displayed properly.

IntelliCAD now works properly when multiple linetypes are imported at the same time.

Print features

User-defined print style tables are now saved in C:\Documents and Settings\user\My Documents\Print Styles per
Microsoft” Windows™ logo requirements.

The Print Style file name dialog box now disallows invalid file names.
Long file names are now visible in the Print Style Table Editor dialog box.
The options on the Printing tab found in Tools > Options are now unavailable when no drawings are open.

IntelliCAD now works properly when print style settings cannot be detected.

ACIS and 3D solids
ACIS primitives are created with the current color setting now (not always BYLAYER).

Match properties

The MATCHPRORommand copies the polyline width if all segments of the source polyline are the same width.

Entity properties

The ENTPRORommand allows you to change the width of a polyline correctly.

Relative paths now work properly for entity hyperlinks.



Display
[ ]
[ ]

Zoom Extents calculates the view correctly when entities are extended outside of the current view.

You can view changes made with DVIEW without an additional REGEN.

OLE objects remain visible even when links are broken.

Dynamic mouse wheel zoom centers the zoom properly on the cursor location when using multiple monitors.
All nested MINSERTentities now display properly.

VPLAYERfreeze now works properly for entities in paper space.

Constant, invisible attributes now display properly when ATTDISPis ON.

IntelliCAD consistently displays lineweights in model space viewports.

Previously, if IntelliCAD could not properly display a single entity within a block, it would not display any of the
remaining entities within the block definition. Remaining block entities now display when a single block entity cannot
properly be displayed (for example, if a HATCHentity was too dense to display).

Command bar

API calls

The performance of command bar line scrolling has been greatly improved.
The command bar no longer randomly displays duplicate entries.

The command bar stores its size correctly if you vertically resize it.

Entmod will now correctly create and display attribute entities.

VBA Select method works correctly in IntelliCAD for large selections.

More fixes

IntelliCAD Explorer works correctly when deleting dimension styles or text styles.

Block definitions are added to the block table when a block insert is cancelled.

The AREAcommand correctly reports the perimeter (not the circumference) of spline entities.
XCLIPboundaries are no longer deleted when saving drawings.

Performing certain operations on selected WIPEOUT entities now works correctly.

Extrude works properly on entities created with the RETANGLEcommand.

SOLID entities now properly honor entity color when DXFfiles are imported into IntelliCAD.

The Load/Unload status (DXF group code 280) of image definitions is now saved properly.

Grip selected entities can now be unselected by using the shift key (shift-pick, shift-window, shift-crossing).
IntelliCAD includes improved handling of the sortents table when it contains references to deleted entities.

Exploded blocks with a negative scale factor in one axis no longer rotate ellipse entities incorrectly.

IntelliCAD 6.0 was released on 5/3/2005.



Utilize performance enhancements

Feature Performance increase

True Type Fonts

Pan 4X (400%)
Zoom 7X (700%)
Polylines

Pedit 50X (5000%)
Linetypes

Zoom extents 7X (700%)
Pan 10X (1000%)
Regen 7X (700%)

Hatch Patterns
Regen 50X (5000%)

LISP Performance

General 10X (1000%)
Blocks

Symbol table search 7X (700%)
Regen 7X (700%)
Viewports

Regen 4X (400%)
Model space 4X (400%)
Block display 4X (400%)
Paper space 3X (300%)

Assign print style tables
The following printing features have greatly enhanced your flexibility and control over the printing process:

e Previously you could use the PenMap/Width mapping to associate colors with specific pen widths on your printer. New
print style tables allow you to still specify color-based settings, but also allow you to specify pen widths, linetypes, and
lineweight regardless of color.

* Print style tables (.ctb and .stb files) are stored in files; you can share the files across multiple drawing files or with
other users.

e Print style tables affect numerous existing features, including: New Drawing and New Drawing Wizard; Properties and
Entity Properties toolbar; Change; IntelliCAD Explorer (Layers); Drawing Settings > Entity Creation tab; Status bar;
Options > Paths/Filestab; Options > Printing tab; and Print > Advanced tab.

There are also several new commands for print style tables: Print Style (printstyle), Print Styles Manager (stylesmanager),
Convert Drawing Print Style Tables (convertpstyles), and Convert CTB Print Style Table (convertctb).

Manage external references

Attaching and working with external references is now easier with the new Xref Manager. You can view a detailed list of the
referenced drawing, or you can view a hierarchical display that shows how drawings are nested and related to one another.
Quickly attach, detach, reload, bind, open, and change the path for all external references in the current drawing.

The Xref Manager allows you to use the same external reference features as in previous versions of IntelliCAD, but in a more
efficient manner.

Work with 3D solids

IntelliCAD Standard version now supports viewing and limited editing of 3D solids, including moving, rotating, and scaling.
IntelliCAD Professional version still allows you to create and more completely edit 3D solids.

Use entity snaps
The existing Intersection Snap has a new Extended option, which snaps to the logical location where two entities would intersect



if they were of infinite length.

The new Apparent Intersection Snap tool snaps to the intersection of two entities that are not in the same plane but seem to
intersect in the current view. You can also use its Extended option, which snaps to the logical location where two entities would
intersect if they were of infinite length.

Customize more options
The following features are new to the Tools > Options dialog box:

e Generaltab N Set the default save format. Specify how drawings are opened.
Paths/Filestab Specify search paths for print style tables.

e Displaytab N Use Up/Down arrows in the command history. Show or hide the Model and Layout tabs. Show or hide
scroll bars.
Profiles tab Create and manage drawing environment profiles.

e Printing tab N Specify headers and footers for all drawings. Assign default print style table settings for new drawings.

Save and restore drawing environment profiles

Customize the settings that control your drawing environment, and then save and restore those settings in a profile. For
example, if you prefer working with custom menus and toolbars, you can save these settings as your own profile.

Profiles can be helpful if you have multiple users with different preferences, or if you are a single user who works on various
projects that require unique settings. You can even export your profile and bring it with you when you work on a different
computer.

Navigate model space and paper space

Use the enhanced Model/Paper Space control in the status bar to switch more efficiently between model space and paper space
on either the Model tab or a Layout tab.

You can also change the display of the Model and Layout tabs in the following ways:
e Show or hide the Model and Layout tabs.

e Reorder the position of the Layout tabs.

Work in the command bar
In the command bar, you can do the following:

e Selecttext, and then right-click to copy, cut, and paste.
e PressCtrl + K and Ctrl + L to move forward and backward in the command history.

e Usethe Up and Down arrows to scroll the command history, if enabled by choosing Tools > Options.

Choose single IntelliCAD sessions

Use the new Single Sessioncommand (type singleton) to choose whether IntelliCAD can be started one time or multiple times
simultaneously.

Use new system variables

New system variables include: APBOX,CPLOTSTYLECTRLMOUSEDEFLPSTYLEDEFPLSTYLEDEFPLSTYLETBIEONTALT,
PSTYLEMODEPSTYLEPOLICYMBUTTONPANSAVEROUNDTRIPand SHOWTABS.

IntelliCAD 5.1 was released on 1/12/2005.



Open files

Fixed a problem with opening files with complex linetypes.

Fixed problems with entity ordering on drawing load.

Save files

When saving a file DWGdirect was using the wrong set of color indices which cause the value of CColorin the
drawing header to be wrong.

Fixed a problem where saving a drawing with an image resulted in the image not being saved in the output file.
Fixed a problem with dimensions seeming to move on save.

Fixed a problem with saving files with complex linetypes.

Fixed a problem with saving solid hatches.

Fixed problems with layouts not being saved properly.

Fixed problems with non-plan view images not being saved properly.

Fixed problems with binary data in external references not being saved properly.

Fixed problems with hatch scale not being saved properly.

SORTENTSTABLE

SORTENTSTABLESot longer created when they should not be.

Empty SORTENTSTABLESre no longer created when they do exist and are not empty.
Other fixes

Other fixes

IntelliCAD no longer crashes when using BHATCH/SelectArea.

DWGfiles can now be exported to SVGformat.

Fixed crash when editing or trimming heavy (pre-R14) polylines.

Changed all project settings to use the same common language runtime.

Fixed random crashesthat occurred when moving the mouse during viewport creation.

Fixed a problem with external references in model space viewports not respecting VPLayerfrozen layer settings.

IntelliCAD 5 was released on 10/24/2004.

Navigate with the Model and Layout tabs

New tabs located at the bottom of the drawing area allow you to switch how you view your drawing.

Use the new Model tab to create your drawing. When you are ready to print, you can optionally use one or more Layout tabs to
design how you want your drawing to look when it prints on paper.

While working on a Layout tab, you can still view and work with your drawing on the Model tab, but you can also add items for
printing, such as a title block or legend, that do not appear on the Model tab. When you are ready to view and work with only
the model again, simply click the Model tab.



Apply lineweights
The width of entities in your drawing can be controlled with the new lineweight feature. You can assign lineweights to entities
and layers, and you can also specify whether they display or print.

Work with files
There are many new file formats supported for opening, saving, and exporting files.
You can now open these additional files:

e Design Web Format? (.dwf) files. DWF? files allow you to distribute your drawing to others to view in a Web
browser, review, and edit using free Autodesk™ software and tools.

e AutoCAD2004 drawing (.dwg) files.
e Drawing (.dwg) files that you suspect are damaged.
e Drawing template (.dwt) files.

In addition to recovering drawing files that you suspect are damaged, you can also audit files to check for errors.
You can also save to these additional file formats:

e AutoCAD2004 drawing (.dwg) files.
e Drawing template (.dwt) files.
You can now export to these additional file formats:
e Design Web Format (.dwf) files.
e Scalable Vector Graphics (.svg) file format, which is a graphics file format and Web development language.
e |n addition to the various new file formats that are supported, you can also drag-and-drop drawings from Web sites

that support the Autodesk™ i-drop” technology.

Reorder entities

When multiple entities overlap, you can change the order in which they display. Choose Tools > Draw Order to move entities to
the front, back, or on top or below of another entity.

Use updated toolbars
You can now choose dimension styles from the Dimensioning toolbar.

When you modify the properties of entities in your drawing, you can use the new Entity Properties toolbar for your editing
needs. Use the toolbar to accessthese features:

e Set layer by entity

e Set layers and accessthe IntelliCAD Explorer
e Selectcolors

e Selectlinetypes

e Select lineweights

Use keyboard and mouse shortcuts
You can use the following keyboard and mouse shortcuts:

e PAN: Ctrl + Shift + Hold down right mouse button.
e ZOOMIN AND OUT: Ctrl + Shift + Hold down left mouse button.
e ROTATEVIEW ABOUTZ-AXIS: Ctrl + Alt + Hold down right mouse button.
e ROTATEVIEW IN 3D ORBIT: Ctrl + Alt + Hold down left mouse button.
e ENTITY SNAPSETTINGS:Shift + Click right mouse button.
After selecting entities, you can move the cursor over the entities and do any of the following:

e MOVE:Hold down left mouse button and drag to new location.



e COPYAND MOVE:Ctrl + Hold down left mouse button and drag to new location.
e SHORTCUTMENU: Click right mouse button to select from a list of various commands that are related to the entity
selection.

Use new system variables

New system variables include: AUDITCTL,CELWEIGHT FONTALT,LAYOUTREGENCTILWDEFAULTLWDISPLAY LWUNITS,
PEDITACCEPTRASTERPREVIEWSAVEROUNDTRIPand STARTUP.

Important  fixes

IntelliCAD 5 includes various fixes, including the following:
e Improved solid modeling.

e Improved performance and stability.

IntelliCAD(R) 4 release by InteliCAD Technology Consortium

IntelliCAD 4 was released on 3/14/2003.

New features

Multiple layouts
In paper space, you can use multiple layouts for different paper sizes and settings.

Unicode characters

IntelliCAD now supports the Unicode character encoding standard, which enables you to display and write text in different
languages using different letters.

Enhanced block insertion
Using IntelliCAD Explorer, you can insert blocks from any open drawing into another open drawing.

New system variables
New system variables include: DIMFRAC,DIMLUNIT, DIMATFIT, DIMLDRBLK,DIMTMOVE,and MTEXTED.

Important  fixes

IntelliCAD 4 includes various fixes, including the following:
e |mprovements to ACIS solid modeling.
e Improvements to complex linetypes.
e Improvements to multiline text.
e |mprovements to lightweight polylines.
e Improvements to display engine.

e Improvements to the memory model.

IntelliCAD(R) 2001 v3.3 release by InteliCAD Technology Consortium



IntelliCAD 2001 v3.3 was released on 7/19/2002.

New features

IntelliCAD 2001 v3.3 now supports the Microsoft Windows XP operating system.

Important  fixes

DWG format
e Improved support for DWG 2000 and DWG 2002 format files.

Performance
e Substantial stability improvements in the overall code with over 1,000 improvements in memory management.

e Performance improvements with regen/redraw.

Print drawings

e Print settings were improved.

More fixes
e Better handling of TrueType fonts.
e Better handling of entity snaps and complex linetype creation.
e Fixesare included in the area of "buffer-overrun" errors.
e Complex linetypes fixed.
e [ eaderarrows can be printed.
e Flyover snapping has been improved.

e COMAPI: Common dialog boxes can be accessedfrom within the VBA environment in IntelliCAD.

InteliCAD(R) 2001 Release by InteliCAD Technology Consortium

IntelliCAD 2001 was released on 5/22/2001.

New features

IntelliCAD 2001 includes the following new features:
e Linetype support
e Complex linetype support
e Display of ACIS solids

e Dynamic viewing features



Important  fixes

IntelliCAD 2001 includes key performance enhancements and fixes such as inclusion of flyover snapping and multiple undo
operation.

InteliCAD(R) 2000 release by InteliCAD Technology Consortium

IntelliCAD 2000 was released on 3/6/2000.

New features

Print drawings

Print drawings using a new streamlined Print dialog box where you can assign printer settings rather than assigning settings
through a separate menu. Use PCPfiles and pen color mapping.

You can view your drawing before you print it using the new WYSIWYGprint preview.

Use a tablet
Use stylus-based input devices using new support for digitizing tablets through the popular WinTab interface.

Important  fixes

Performance
e Improvements with real-time pan and zoom performance to speed user navigation throughout drawings.

e Improvements in stability.

More fixes
e You can now use XREFlayer control within the VPLAYERand VISRETAINcommands.
e [Improvements with AutoCAD compatibility.
e Boundary polygon (BPOLY)command: streamlining the placement of hatch patterns.

e Added alternate units and tolerances in dimensioning.

IntelliCAD(R) 99 Beta release by Visio Corporation

IntelliCAD release in September 1999 by Visio Corporation for the creation of the ITC.

InteliCAD(R) 98 release by Visio Corporation

First release on 4/1/1998 of the IntelliCAD technology by Visio Corporation.



